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Introduction (Extracts from the Model Curriculum Document):
The computer curriculum for each standard is broadly divided into three groups:
1. Concepts: Learning computer science concepts that are generally useful in many areas as
well as some concepts that are specific to computer usage/functioning.
2. Usage Skills: Developing hands-on skill in the use of various hardware/software and
programming packages/languages.
3. Social Aspects: Understanding ethical and security related issues of computer and Internet
usage.
The emphasis is on understanding the concepts behind various computer-based activities,
rather than just the usage skills of specific tools. It is hoped that such a concept-oriented
approach will equip the children to be self-learners and enable them to cope with the inevitable
advent of new tools and technologies of the future.
The design approach of this curriculum is to keep the primary section as elementary as possible,
have a slight ramp up during middle school and further ramp up in secondary section to meet
the syllabus prescribed for the Board exams.
For each standard, a 32-week schedule is given. Week Nos. 1, 2 and 3 are reserved for revision
of the previous Standard. Week Nos. 8, 15, 24 and 31 are for revision of the current Standard.
Week Nos. 16 and 32 are reserved for evaluation and assessment. Assuming 10-weeks of
vacation, there is still a 10-week buffer for the teacher. This can be used for giving more time to
difficult topics, for additional revisions/evaluations and for project work.

The teaching material attempts to be vendor-neutral (independent of software platforms).
Lesson outlines are to be provided for both Windows XP and Linux Systems (Ubuntu).
Hardware specifications and software installation and maintenance guidelines are provided in
Annex C, D and E (of the main curriculum document).
A creative commons approach is used for generating the lessons and worksheets. All are
welcome to participate in this effort. For each topic, detailed subtopics are listed; using which
anyone interested can write the lesson outline. The lesson is then reviewed and after approval,
may be incorporated into the curriculum. The author retains the rights over his/her work while at
the same time allows others to use/modify it freely (without copyright issues).
4

4th STANDARD
What: At the end of 4th Std, a child should know:
●

Concepts: Information handling; Workflow notions; Keywords (Syntax).

●

Usage Skills: Using common devices and applications; Information handling and
movement of data between different storage areas; Word processing and elementary
making of slides; rudimentary programming (using a language like LOGO).

●

Social Aspects: Awareness of computer-usage posture, eye-care; Keeping the computer
safe from malicious use; Ethical issues?

Why: At the end of 4th Std, a child should be able to find the necessary information to carry
out simple tasks using the computer. The child should be able to configure, customize
programs (Control Awareness). A child should be equipped to independently learn the
preliminary use of common applications.
How: There should be one class per week, roughly as per the following schedule:
Week

Topic

4-1

Assessment of knowledge retained from 3 Std portion.

4-2

Revision of topics from 3rd Std based on above assessment.

4-3

Revision of concepts from 3rd Std continued

4-4

Using external media such as CDs and Pen Drives.Such as: Reading from a CD;
Writing to a Pen Drive

4-5

Using multimedia hardware and software such as Webcam. Such as: Take your own
photo using a pre-configured webcam.

4-6

Additional features in Word processing.Such as: fonts, formatting and other
commomnly used ones.

4-7

Advanced features of Word processing.Such as: inserting pictures/objects, making
tables.

4-8

Worksheets and lab exercises for Word processing.

4-9

Simple introduction to making Presentations.Such as: Open a Presentation software,
write text in one slide.

4-10

Concept of making slides&logical flow from one to the next.Such as:4slides on what
5

Week

Topic
they do on a typical day; slide show.

4-11

Worksheets and lab exercises for fun with Presentations.

4-12

Concepts of workflow.Such as: similar to a slide show on any activity.

4-13

Reinforce concepts of step-wise logical thinking. Such as: Those learnt in 3 Std.

4-14

Worksheets for illustrating workflow concepts.

4-15

Revision worksheets and lab exercises.
Objective up to this point: continue on the topic and introduce a new concept.

4-16

Evaluation and Assessment

4-17

Different types of file extensions Eg: txt,doc,ppt

4-18

Organizing a storage hierarchy (creating folders etc).Such as: keeping all related files
in a sub-folder.

4-19

Managing a storage hierarchy (moving files around).Such as: Moving files between
folders using copy-paste, drag-drop.

4-20

Worksheets and exercises for organization.

4-21

Concepts of simple programming.Such as: Need for detailing steps, use of keywords.

4-22

Simple programming with a language like LOGO.Such as: using the most
elementary commands.

4-23

LOGO related Game in EDUBUNTU(compris-experiential-sea race)

4-24

Revision worksheets and lab exercises.
Objective up to this point: continue on the concept of organized thinking

4-25

Continue with simple programming.Such as: commonly used commands in a
language like LOGO

4-26
4-27

Worksheets and lab exercises for programming.
Evolution/History of computers.Such as: story to set the stage for networked
applications.

4-28

Internet applications (demo only; no hands-on).Such as: Google; Email (demo only)

4-29

Further Do’s and Donts.Such as: Posture and Eye care.

4-30

Reinforce the safety aspects.Such as: Dangers of Viruses and malicious intent.

4-31

Revision worksheets and lab exercises.

4-32

Evaluation and Assessment.
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Title:

Additional features in Word processing. Such as: fonts, formatting and
other commonly used ones.

Date:

August, 2007

REF No:

4.6

Contributers:

Usha Viswanathan

Std:

4

Reviewers:

Farida

Brief Description:

This topic deals with the additional features in text processing.

Goal:

The aim of this lesson is to help the child use a text processor
application effectively.

Pre-requisites:

The child should know what a text processor is and how to open it.

Duration:

1 hour

References

http://www.atis.org/tg2k/_word_processing.html
http://www.jarte.com/help/hs50.htm
http://jan.ucc.nau.edu/~lrm22/technology/wpbasics/wpbasics.htm

Detailed Description
What is text (word) processing?
Text or word processing generally refers the use of computers to manipulate text. Examples of word
processing functions include entering, editing, printing, etc.
We already have learned how to open and save a document after typing in some data in a text
processor. We also have seen some of the most commonly used formatting tools. Using all these
tools we can change the look and feel of the text typed We can change the font style/ size, make the
text bold/ italic, underline, etc. Apart from these functions we can also highlight the text and change
the background colour.
The following figure shows some of the tools available to format the text, which we already are familiar
with.
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Now let us look at some other formatting tools. Consider, we want to write an essay on “Our school”.
The heading/name can be written in bold letters. Then it will be placed in the center of the line. Now
the paragraph will start from the left hand side of the page. For doing all these functions, we can use
the paragraph formatting tools. These are available under the 'Format' option on the menu bar. We
can even specify the indent (the blank space between a margin and the beginning of a line) provided
for each paragraphs. If needed the we can also align to the right, center or justify the typed in text. The
figure shows tool bar short cuts for these functions.

Different styles for numbering and bullets are also available. To access this option from the menu bar
go to Format -> Bullets and Numbering. See the figure below.
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The following figure shows the different bulleting options available .

From the above window among other features, we can apply different styles of bulleting and
numbering to a hierarchical list.
The following are the tool bar shortcuts for bullets and numbering

9

All these tools can also be accessed by a simply right click of the mouse to get the drop down menu
options, where you can select them.
Lesson Plan
1. First revise the Class 3 content on text processing and formatting. For this we can give a small
assignment to write a paragraph where all the already formatting tools are to be used.
2. Keep a document ready with some paragraphs on any interesting topic (This is to show them
the tools available to format a paragraph).Now using the tool bar short cuts, show them how to
align the text to the left or right, centered or justified. Do this slowly so that the idea sinks in to
the child's mind.
3. Now demonstrate how to bullet or number a document. For this we can use a worksheet where
there are a number of questions. Use the bullets/ numbering buttons on the tool bar to show
how they can be numbered.
4. Once they get the idea about bullets and numbering, we can show the different types of bullets
and numbering options available.
5. Show them we can access these functions following either of these:
Format (from the menu bar) -> Bullets and Numbering.
Right click -> Numbering/Bullets (from the drop down menu)
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Title:

Advanced features of Word
pictures/objects, making tables.

processing.

Date:

August, 2007

REF No:

4.7

Contributers:

Usha Viswanathan

Std:

4

Reviewers:

Farida

Such

as:

inserting

Brief Description:

This topic deals with the additional features of text processing, like
inserting tables and pictures in a document.

Goal:

The aim of this lesson is to help the child use a text processor
application effectively.

Pre-requisites:

The child should know what a text processor is and how to open it.

Duration:

1 session

References

http://whatis.techtarget.com/definition/0,,sid9_gci212942,00.html

Detailed Description
Text or word processing generally refers the use of computers to manipulate text. Examples of word
processing functions include entering, editing, printing, etc.
Once comfortable with the basic formatting tools of word processing we can proceed towards the
more advanced topics like inserting tables and pictures.
Most of the times, we come across documents and textbooks that contains colourful pictures and
tables along with written material. How can one insert pictures and tables while writing text in word
processor?
Inserting Pictures
Let us see now How we can insert a picture. For this, choose the menu bar option “Insert”, we will get
a drop down menu as shown in the figure below. Select the option “Picture” from this list. Here you
get two options : either you can insert the picture from a file or you can scan the picture and then
insert it into the document.
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To insert a picture from a file, select the “From File “ option under “Picture” (see above figure). This
opens up another window asking to select the file which is to be inserted.

Go to the location of the picture, select it and then click “Open” button to insert the picture.
If we want to insert a picture after scanning, select the scanner and then scan. Now the picture can be
inserted into the document.
(Note: A scanner is an input device that captures images from photographic prints, posters, magazine
pages, and similar sources for computer editing and display.)
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Apart from inserting pictures, you can even insert graphs/ charts/ movies/ sound etc.

Inserting Tables
Sometimes in our documents we need to present the information in the form of a table. For example:
In our class we need to compare the marks obtained by the students in an exam. Instead of referring
all the answer sheets, we can make a table containing the student's name along with the mark
obtained in different subjects. Such a table makes our task much easier.
How can we insert tables? The main menu bar itself gives you the option “Table” for inserting tables
into your document. Select the “Insert” option from the drop down menu and then select “Table”.

A window pops up asking the number of rows and columns for the table. You can also give a name to
the table else by default it is named as 'Table1'. When more tables are inserted into the document,
they will be numbered sequentially.
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Once a table is inserted, more rows or columns can be inserted using the options 'Rows' and
'Columns' from the main menu bar option “Insert”. Also we can add or remove rows or columns using
the mouse right click. For this keep the mouse cursor anywhere on the table and right click. We get a
drop down menu as shown in the following figure.

We can also merge/ split rows and columns, increase/ decrease row height and column width, etc.
You also can hide table boundaries, have captions for the table, etc. The tool bar short cut for adding
(inserting) table into a document is also available.
Lesson Plan
1. To start with ask few questions to the kids about the different word processor formatting
features they are familiar with.
2. Now show them a colourful document with pictures (in the computer or hard copy of any
document) and ask whether they have ever wondered how pictures are inserted into
documents.
3. Open the word processor application. Show them the menu bar. Show the 'Insert” option.
4. Now insert a “Picture' and then show its functionality. Similarly show them how to insert
graphs/ charts/ movie/ sound.
5. When they are through with how to insert pictures/objects, go to the “Table” option on the menu
bar and show how to insert table into the document.
6. Show how rows and columns can be inserted or removed, how the row height or column width
can be increased or decreased.
7. Now ask the students to open a document and practice the things shown to them.
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Title:

Worksheets and lab exercises for Word processing.

Date:

September, 2007

REF No:

4.8

Contributers:

Usha Viswanathan

Std:

4

Reviewers:

Farida

Brief Description:

Worksheets and Lab exercises for Word Processing

Goal:
Pre-requisites:
Duration:
References

Work Sheets

1. Round the tool bar short cut for bulleting a document.

2. What are the four different styles with which the the text in a paragraph can be
aligned?
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3. Riya is preparing a document she wants to use the numbering option. Number
the steps to be followed correctly and help her. Is there any other way she can do
it? If yes, how?

4. Match the tool bar shortcuts with their functions.

16

5. Identify whether Bullets/ Numbering style.

6. Fill in the blanks by selecting the correct option.
●

●

●

You can reach the 'Bullets and Numbering' option by clicking _________ on the
menu bar. ( Format
Insert
Edit)
To insert a table into the document we can click the _____________ option on
the menu bar. ( Insert
Table
Format)
The menu bar option to insert a picture into a document is ___________.
Insert
Format)
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( File

7. Raju is preparing a document. He wants to include a table and picture in the
document. Can you tell him which options he should select by rounding them off.

Lab Exercise
●

●

●

Write a story about the above picture. Write the title in central alignment and the
story in justified.
List out the different things you do in the morning before going to school. Now
write them with appropriate bullets/numbers.
Make a poster about your school using all the formatting tools you are familiar
with.
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Title:

Simple introduction to making Presentations. Such as: Open a
Presentation software, write text in one slide. AND
Concept of making slides&logical flow from one to the next. Such as: 4
slides on what they do on a typical day; slide show.

Date:

September, 2007

REF No:

4.9, 4.10

Contributers:

Usha Viswanathan

Std:

4

Reviewers:

Farida

Brief Description:

This lesson introduces to the child how to make a presentation and
how it can be effectively used to put through a concept.

Goal:

To help the child prepare a presentation on his/ her own.

Pre-requisites:

The child should know how to start an application.

Duration:

2 sessions.

References

Detailed Description
Consider you want to tell your friends in your native place about your school, if you just tell about your
school, it becomes boring. How will you make it interesting? If your speech is also supported by a set
of pictures and sound, it becomes more attractive. You can write about your school along with
colourful pictures of your school and your friends there. You can even add some sounds to it ! Let us
see how we can do this!
This can be done using an application which will help you to present information in a slide show
format. In edubuntu, we have the 'OpenOffice – Impress', which will help you in doing this. In the
windows operating system, similar application is named as 'PowerPoint'.
The application can be accessed in edubuntu, from the 'Applications' menu on the Desktop.
(Applications -> Office -> Presentation)
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Once the application is selected, it opens a window which guide us step by step to start a
presentation. First either we can open an existing presentation or create a new presentation. Now, let
us select the option to create an empty/ new presentation.

In the next step, we can select the backgrounds from a list of existing backgrounds.
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Once the background is selected, we have to decide upon the way the figures and written text are to
be presented. We can even select the duration a particular page/ slide shall be displayed.

Once all is set, our empty presentation is ready. See the following figure.
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Just like the word processor application which you now already know, OpenOffice-Impress is also
provided with a menu bar and tool bars which will help you in creating the presentation.
The left hand area shows the the reduced image of all the slides in the opened presentation. The right
hand area gives the different styles/ layouts we can use for each slide in the presentation and the
central area gives the contents of the selected slide.
How to add figures and text to a slide?
The first step to now is to select the layout we need for a particular slide. Once the layout is in place,
just click on the area where we want to add the text or picture. A sample slide is shown below.
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You can add more slides to the presentation using the 'Insert' option on the menu bar or you can use
the tool bar short cut.(See below figure).

When the students are familiar with how to create a new presentation, we can proceed towards
creating a full presentation. For example: we can create a slide show of the different activities of a
child on a typical school day. Now ask the students what are the different things they do on a typical
school day. Make a general list of different activities
Now list out the different activities:
● Get up early in the morning.
● Take bath and get ready.
● Have milk and go to school.
● Attend Prayer, then study and play.
● Come back home. And have lunch.
● Then sleep for sometime. Get up, wash and eat.
● Go to play. Come back home do the homework and study.
● Have dinner, keep the books ready for next day at school.
● Go to sleep.
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In the class we can create a condensed version of the same sequence (say 4 slides).
1. Get up early in the morning
2. Go to school
3. Play in the evening.
4. Go to bed.
Now create the presentation.
Lesson Plan
1. Tell the kids how pictures and text can help you to put through an idea.
2. Show them a slide. Explain what a slide is?
3. Ask them whether it will be fun to make a slide together.
4. Show them how to open the application. Now go through all the steps to open an empty slide.
5. The students are already familiar with the most of the tool bar buttons (most of the shortcuts
are same as in word processor application). Stress on the short cuts specific to the
presentation application.
6. Now select a layout for the presentation and create a slide.
7. Once they are comfortable with the application, proceed towards creating a presentation.
8. Ask the students what presentation they want to make. Decide upon a topic.
9. List them out. Divide the class in to small groups and tell them to create a presentation out of
it.
10. To get them started, we can show a small sample presentation.
A sample presentation is given below:

24
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Title:

Worksheets and lab exercises for fun with Presentations.

Date:

September, 2007

REF No:

4.11

Contributers:

Usha Viswanathan

Std:

4

Reviewers:

Farida

Brief Description:

Work sheets for fun with Presentations.

Goal:
Pre-requisites:
Duration:
References

Worksheets
1. Fill in the blanks.
● OpenOffice – Impress helps you to make a
(Document
Spreadsheet
Presentation)

The pages in a presentation are called
(Slides
Papers
Notes)
●

.
.

The 'Impress' application for creating presentation can be accessed from the
option under the 'Application' menu on the task bar.
( Office
Graphics
Internet)
●

2. Round off the icon for OpenOffice – Impress application file.
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3. Raju wants to open “Open Office – Impress” application. Can you help him by
numbering the steps he should follow to open the application.

Lab Activities
Prepare a list of thing you will do before going to bed at night. Now create a
presentation on this. Present it as a slide show before the class. (This can be done in
groups)
Activity
●

We all know that “ Unity is Strength” . Here are some pictures of a story which will
tell us this. Cut them and arrange them in the correct sequence. Develop the
story. Create a presentation by pasting the pictures along with the story.
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●

You are going on a trip. List out the various preparations to be done before
leaving for the trip. Cut colourful pictures from magazines or newspapers. Now
make a presentation for the activities we listed out.
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Title:

Concepts of workflow. Such as: similar to a slide show on any activity.

Date:

November, 2007

Contributers:

Usha Viswanathan,
Neela Srinivasan

Std:

4

Ref. No.

4.12

Reviewers:

Farida

Brief Description:
Goal:
Pre-requisites:
Duration:
Detailed Description
You must have played game of cricket. This is a game where two teams play against each other. We
have two innings in a game, only if a team plays the first innings can the second team start their
innings. Also the game is to be completed in a specified time. You must have noticed if for any reason
the play is delayed (example: rains) then the number of overs is reduced to adjust the time.
Now consider another example: your teacher has asked you to read some stories from Panchatantra
and then write a short paragraph about the same. You have to complete this homework in one week
(say this Friday to next Friday). What will you do?
To make the task (something which needs to be done) easy and to complete it in time, let us first
break down the single task into smaller, simpler tasks which needs to be completed in a specific
amount of time. Now “how do we break it down into simple steps that can be achieved a little bit at a
time?”
For this first we have to :
●
●
●
●

Understand what the paragraph is about. If you know, you can proceed to the
next step. If
you don’t, you need to ask someone what it is about.
Get Information about the topic. Now ask yourself “How do I get the required information?” The
answer may be: Books/ Internet
Estimate time to do each of the steps
Allocate time to perform each of the steps.

Coming back to our task in hand, the time given here is one week (seven days). Now let us make a
table with the tasks and the approximate time we need to complete each task.
Tasks

Estimated time

When

Decide upon the story.

2 hours

Friday night

Now get the book.

One day

Saturday

Read the book during your free time

Three days

Sunday, Monday night, Tuesday night

Decide upon what to write.

2 hours

Wednesday night

Write the paragraph.

2 hours

Thursday night
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After deciding upon the time schedule, first we will decide upon which stories of Panchatantra to read.
Now get the story book(s). If you don't have a copy of the book, you can either buy it from a shop or
approach the library or a friend. Only if you get the book we can start the next task namely reading the
book. So this task is dependent on the previous task. Let us say we took two days (Both Saturday and
Sunday)to get the book instead of a day what will happen? The succeeding tasks now have lesser
time for completion.
In both the above cases to complete one task, another task needs to be done (dependencies). Also
the tasks is to be completed in a specific amount of time.
This can also be compared to a slide show presentation. A presentation is divided into a number of
slides (just like a big task is divided into smaller tasks), where one slide comes after another. If a time
frame is given for each slide; the presentation can be completed in a specific amount of time.
To understand the concept more clearly, we can prepare a flowchart . Let us take the above example :
Read the stories and write a paragraph about the same.
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Lesson Plan
Ideally, this unit should be taught with a long-term, team project. The project includes data gathering,
collating and presentation, perhaps using a computer.
This unit can be done without a computer as part of a class in a different subject (science, social
studies, literature).
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At the end of the unit, the students present their discoveries with the class. They can use Power Point,
Word and/or Spreadsheet software to organize their data and their presentation.
Discuss and elicit a work-flow for a sample project such as the one shown detailed discussion.
Some sample projects: Time: 4 weeks. Team size: 2 – 4 students.
Investigate the flora and fauna in the student’s neighborhood. They can collect samples of
leaves, flowers. Or, they can be given a disposable camera to take pictures of flora and fauna
that they can incorporate in their presentation. They can use the scanner to scan their pictures
in, paste the images into their presentation using Power Point or Word, organize their data in a
Spread Sheet, etc.
Investigate the different types of games that children play in their school.
Investigate the different types of vehicles that they see on the roads.
The students can be encouraged to come up with their own project. This inculcates creative
thinking and curiosity in their surroundings.
The students must follow the procedure outlined in the “detailed discussion” section.
At the end of the lesson, when all the teams have done their presentation, gather the students and let
them share their experiences with each other. The teacher moderates the discussion and the class
brainstorms for the solution.
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Title:

Reinforce concepts of step-wise logical thinking. Such as: Those
learnt in 3 Std.

Date:

November, 2007

Std:

4

Ref. No.

4.13

Reviewers

Farida

Contributers:

Usha Viswanathan,
Neela Srinivasan

Brief Description:

Develop logical thinking in the student.

Goal:
Pre-requisites:
Duration:
References

http://www.audiblox.com/logical_thinking.htm
http://www.nwrel.org/scpd/sirs/4/snap13.html
http://members.tripod.com/~srinivasp/mythology/panchatantra.html

Detailed Description
Logical thinking is an important foundation skill. But it is a skill that needs to be taught. There are
many everyday life situations in which the ability to think logically is of great importance. we can
consider the example taught in the previous standard: you are standing in a busy road crossing. You
have to wait for the red signal to cross the road. What will happen if you cross during a green signal?
You will be hit by a vehicle.
Skills in logical thinking also serve as foundation for effective computer use. It is an important
requirement for not just computer professional but also several jobs and daily activities. Computer
games can be an effective mechanism in training students in logical thinking.
Lesson Plan
1. Start the class with an everyday life example. You are walking down the road. You see a
sweets vendor selling some sweets on the roadside. The sweets are kept open. You are
tempted to buy and eat some. What will happen if you eat them? Let the students answer.
2. Take some more examples, which will let them to think and take a decision.
Why should I be careful while playing with fireworks?
Why should I walk along the footpath?
Why should I share things with my friends?
Why should we purify drinking water?
3. Now narrate a story to make the clear that why we need to think of the consequence before
doing something.
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The Foolish Lion and the clever rabbit
Once upon a time there lived a ferocious lion in the forest. It was a greedy lion and started killing
animals in the forest indiscriminately. Seeing this, the animals gathered and decided to approach the
lion with the offer of one animal of each species volunteering itself to be eaten by the lion everyday.
So every day it was the turn of one of the animals and in the end came the rabbits' turn. The rabbits
chose a old rabbit among them. The rabbit was wise and old. It took its own sweet time to go to the
Lion. The Lion was getting impatient on not seeing any animal come by and swore to kill all animals
the next day.
The rabbit then strode along to the Lion by sunset. The Lion was angry at him. But the wise rabbit was
calm and slowly told the Lion that it was not his fault. He told the Lion that a group of rabbits were
coming to him for the day when on the way, an angry Lion attacked them all and ate all rabbits but
himself. Somehow he escaped to reach safely, the rabbit said. He said that the other Lion was
challenging the supremacy of his Lordship the Lion. The Lion was naturally very enraged and asked to
be taken to the location of the other Lion.
The wise rabbit agreed and led the Lion towards a deep well filled with water. Then he showed the
Lion his reflection in the water of the well. The Lion was furious and started growling and naturally its
image in the water, the other Lion, was also equally angry. Then the Lion jumped into the water at the
other Lion to attack it, and so lost its life in the well. Thus the wise rabbit saved the forest and its
inhabitants from the proud Lion.
Here are the pictures of the above story. The pictures are in a jumbled order. Can you now arrange
them in the proper order by numbering them.
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Worksheet
1. A drawer contains 10 black and 10 brown socks that are all mixed up. What is the
fewest number of socks you can take from the drawer without looking and be sure
to get a pair of the same color?

2. Two fathers and two sons went fishing. Each caught exactly one fish and yet
there were only three fish caught. Why?
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3. Here is a sequence of colours. Guess what colour comes in the next two spaces?

Sudoku Puzzles
● Observe the following table. You can use only the numbers from 1 to 4. All the
rows and columns should have these numbers(1, 2, 3, 4) and only once. Fill in
the missing numbers.
2

4

1

3

2
1

3

4

2

●

2
1

Observe the following table. All the rows and columns need to filled in with the
shapes: Circle, Diamond, Square and Rectangle. All the rows and columns
should have these shapes. Now complete the puzzle.
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4. Make the following numbers with the numbers 1, 3 , 7, 9. You can use the
operations addition, subtraction, multiplication and division.
Example: 0 = 7 + 3 – 1 – 9
●

1=

●

2=

●

3=

●

4=

●

5=

Activities
1. A Tangram consists of seven pieces, which fit together to form a shape of some
sort. The shape has to contain all the pieces, which may not overlap. Tangrams
puzzles are a great tool to enhance student’s thinking, creativity, and problem
solving skills.
2. Teacher can make more advanced Sudoku puzzles with operations addition,
subtraction, division or multiplication) and the students can solve them.
3. The students can attempt to make a kaleidescope and see the emerging patterns.
Reason out how the patterns are formed.
4. The class is divided into groups. Give some questions and ask them to refer “Tell
me why” books in their library and prepare a short project and each group makes
a presentation. For example:Describe the different ways you can purify water?
5. The students can make some flash cards and they can play games.
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Title:

Different types of file extensions, for example: .txt, .doc, .ppt
Organizing a storage hierarchy (creating folders etc).Such as: keeping
all related files in a sub-folder.

Date:

July, 2007

REF No:

4.17, 4.18

Contributers:

Dhanya, Usha Viswanathan

Std:

4

Reviewers:

Farida

Brief Description:

This topic introduce the different types of file extensions and storing
them in an organised fashion.

Goal:

The student should be able to identify file types from some of the
commonly used file name extensions. He/she will also be able to store
files in a hierarchical manner.

Pre-requisites:

The child should know the concept of files and folders.

Duration:

2 sessions

References

http://www.kidsdomain.com/brain/computer/lesson/comp_les7.html

Detailed Description
Computers can store a lot of information(data). Computers use files and folders to organize these
information. A file is a collection of information with a name attached to it. A file name has two parts:
NAME and TYPE (EXTENSION). Here is a typical file name format : filename.filetype. Usually the file
types or extensions are written as abbreviations or in short form, usually with 3 letters.
Computer files are of different types - text files, music files, picture (graphic) files, etc. the file might
be a text document, a picture, sound, a video, a web page or many other things. The type of the file
can be identified by the extension of the file, which comes after the filename.
Some common file extensions are
● '.txt' for simple text files
● '.jpg/ .gif' for photo or image files
● '.odt' for document files in edubuntu
● '.mp3' for music files
● '.QT', '.mov', '.mpeg' for movie clips
How to store these files?
We now already know that when related files are stored in the same location, it becomes easy to
search and retrieve them. Consider the following example.
Suppose you have created many files containing your study materials for different subjects, like
Science, Mathematics and English. Instead of storing all the materials together, we can create
separate folders for each subject, such as 'Mathematics', 'Science' , 'English, etc. Now you can keep
all the files dealing with mathematics in a single folder. If a subject has other subcategories, we can
also create sub-folders/ subdirectories (Directories inside another directory). For example under
science category, if we have documents relating to plants, animals and our surroundings. We can
create subdirectories 'Plants, 'Animals' and 'Surroundings'. Now we can store the related files in these
sub folders. This way searching for a file become easier.
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The above figure shows some files which are categorised according to their subjects. These can be
stored in a computer according to the storage hierarchy as shown below. Under Science category, we
can again subdivide the files into Plants, Animals and Surroundings.

We can also store files according to the file extensions. For example, consider we have a number of
music and document files . These files can be grouped and kept in a single location. This way we will
know where to look for music or the document files. These files can also be divided into sub
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categories. For example. In music files we have both rhymes and instrumental music. These can be
separately grouped and stored. This way it becomes convenient and saves time in locating a file.

How to create a new Folder?
Go to the location where you want to create a new folder. Right click the mouse, then you will be
provided with a menu , which will look like the one below.

Click on the 'Create Folder' option in the menu. Then a new folder will be created in the current
location and it will look like the figure below
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Now we can give a name to this folder, by just typing the name on the highlighted area. Let us name
the new folder 'First', then it will look like the figure below

Lesson Plan
1. Start the class asking the children what are the steps they followed while saving a file. Now list
out the steps.
2. Open a new document. Type in some matter.
3. Select the save option either from the file menu or from the tool bar shortcut.
4. Show them the pop up window. See the following figure.

5. Now ask them to show the location where the file name is to be entered. In case of a new file,
the file name will be “Untitled” (as shown in the figure). This can be changed and relevant file
name can be given.
6. Now show them the 'File type” option. Here we get the file type on the left hand side and the
three letter extension corresponding to that name on the right hand side. This is the place
where we can decide the type of the file. Once an option is selected then three letter extension
is added after the name of the file.
7. Another question that may arise is why we need an extension. Ask the kids to consider the
school, where there are different classes . Each classes will have kids who are of a particular
age groups. For example, kids of Class I will be of age group 5-6 years. So by knowing the
class of a kid, we can guess his age. Just like this, by seeing the file extension we will know the
content of a file, like '.mp3' for a music file, '.jpg' for pictures, etc.
8. Once the idea of file extensions are clear, click the 'Save' option to save the file.
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9. Now show them some of the already saved files in the computer. Ask them to observe the file
names and extensions.
10. Open some sound/video, paint, word processor or picture files and ask them to notice the file
extensions. Let them get familiarized with some of the commonly used file types.
11. Close all the files and ask them to identify different files types from the file extension.
12. Open the files and show whether they have identified the files correctly or not.
13. Now we will get into the importance of organising the files and how files can be grouped and
stored depending on the file extensions.
14. Tell the students about some day to day activities where we need to keep things organised, like
keeping their text books and notebooks, dresses etc. Ask them why we keep things
organised ?
15. Once the idea is clear, consider the following scenario. One school is there having Classes 1 to
3. We have the details of all the students studying in the school in different classes, like their
photographs, address, etc. How are we going to store them? One simple option is to keep all
the files in one location. But we already have learned that storing files in a well organised
manner is convenient and it also saves a lot of time in locating a file.

16. If there are more than one division under each class, then we can create subfolders for each
division. If the student details( let it be '.odt' files) and photographs (let it be '.jpg' files) are there,
then for different file types we can create separate folders for storing the files. See the following
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figure.
17. Once the idea is clear, we can go ahead with the process of creating a folder. Create a folder
'School' on the Desktop. For this first go to the location(Desktop), right click the mouse and
select the option 'Create Folder' from the drop down menu. Then give the name 'School' to the
created folder.
18. Create a new file in word processor/text editor. Write a brief description of your school and

store in this folder. Ask the children to notice the file extension.
19. For creating sub-folder inside the folder 'School', open the folder and then follow the same
steps as in 17. You can create as many folders and files as you wish and store the files in a
well organized manner.

Worksheet

1. Match the following icons with the respective files.
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2. Identify the file names and file types of the following list of files.

Files
Rhyme.mp3
Parents.jpg
Lion.odt
Cat.gif
Story.mov

File Names

3. Write the file name and file type from the icons.
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Title:

Managing a storage hierarchy (moving files around).Such as: Moving
files between folders using copy-paste, drag-drop.

Date:

October, 2007

Std:

4

Ref. No.

4.19

Reviewers:

Farida

Contributers:

Usha Viswanathan

Brief Description:

This topic describes how to manage a storage hierarchy.

Goal:

To familiarize the student how to manage a storage hierarchy.

Pre-requisites:

Familiarity with Folders and files.

Duration:

1 hour

Detailed Description
We already have seen the importance of having folders and how related files can be saved together.
This will help us to access the files with ease and the information also looks neat and organised.
After creating a folder we can start storing files in them. A folder can store any type of files. We can
move files from one folder to another. To move files from one folder to another, we have two options.
●
●

Select the file to be moved, drag and drop it to the other folder.
Select the file to be moved, copy and paste it to the other folder. Instead of copying and pasting
it to other folder, you can also use the 'cut and paste' method.

Drag and Drop method
To move a file from one location to another using the 'Drag and Drop' method, first select the file
which is to be moved. Now drag and drop the file into the desired folder.
Consider an example: The folder “Surroundings” have lot of files in it. Now we want to group these
files in two sub categories viz. 'Vehicles' and 'Animals' under the folder 'Surroundings'. Here folder
'Surroundings' is called the 'Main' or 'Parent' folder. Inside this we can create two more viz. 'Vehicles'
and 'Animals. Now these two folders are called the 'Sub- folders'.
The following figure shows the contents of the folder 'Surroundings'.
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Now select the file which needs to be moved, drag it to the new folder and drop it. When all the files
are moved into its place, let us open the folder 'Animals' to see its contents. See the following figure.
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Now the information looks neat and organized.

Copy/ Cut and Paste method
Another way to move a file is the copy and paste method. Here the file to be moved is first selected by
clicking (left click) on it and then right click the mouse. A drop down menu appears like the one show
below. Select the 'Copy” option.

If we select the 'Cut' option, then the file to be moved is removed (cut) from its current location.
Now open the folder where you want to paste this file, from this folder right click the mouse. Another
drop down menu appears with the 'Paste ' option. Select it, the file is now pasted in the new location.

In Copy-Paste method the original file is not moved, while in Cut-Paste method the original file itself is
moved to the new location.
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Lesson Plan
1. Keep some files (pertaining to a single topic or subject/ of same genre) ready on the Desktop.
Let it look bit cluttered.
2. Now ask the students how does it look? Let them give suggestions.
3. Ask the students how it will help us if we keep all files organised by keeping related files of a
particular topic/ subject in a single location.
4. In order to keep all related files together, we need to move the files, How can we do this? (from
the previous classes they may have an idea how to do this).
5. Now make a folder on the Desktop. Name it.
6. Now do both the Drag and drop as well as the Cut- Paste method to move the files into the new
folder.
7. Ask the children to notice that in both these methods, the files shift its place from old to the new
location.
8. Now do the Copy-Paste method. Ask them whether they have noticed any difference between
the two methods?

Activities
●

●

Divide the class into small groups, provide each of the group with a set of pictures, say trees,
flowers, cereals, pulses, etc. Now ask them to arrange them into different categories. Give
name to the different categories.
Paste the above pictures on a chart paper under the respective categories.

Lab activities
●

●

Keep a set of picture files (same file type) of different topics ready in a folder. Ask the children
to create new folders with appropriate names and then let them store the pictures
hierarchically.
Keep some files (of different types) of different topics, in a folder. Now ask the students to
organise them. Create folders and then keep the related files in the respective folder.
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Title:

Worksheets and exercises for organization.

Date:

October, 2007

Std:

4

Ref. No.

4.20

Reviewers:

Farida

Contributers:

Usha Viswanathan

Brief Description:

Worksheets on storage hierarchy.

Goal:
Pre-requisites:
Duration:

Worksheets
1. Take a look at your environment. You see lot of plants. Identify some of the
flowering and non flowering plants. List out and then group them.

2. Here are the pictures of some plants. Identify which are terrestrial (land) plants
and aquatic (water) plants. Circle terrestrial plants red colour and aquatic plants
with blue colour.
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3. Following is a list of food items. Classify the following list into carbohydrates, fats
and proteins.
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4. Here is a list of graphic files.

Arrange them as shown below inside the two folders 'gif' and 'jpg'.
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Now answer the following questions.
a) Which are the files inside the folder 'jpg'?
------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------b) Which is the parent folder of file 'Jasmine.gif'?
5. Here is a storage hierarchy given below. Refer the figure and answer the
following questions.
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a) Which are the sub- folders of the folder 'MyFiles'?

b) Which is the parent folder of 'Rhymes' folder?
--------------------------------------------------------

c) What are the contents inside the folder 'Pictures'?
------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------d) Which is the parent folder of file 'Hare and Tortoise.odt'?
---------------------------------------------------------e) Which folder has a file with '.pdf' file extension?
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Title:

Hopping game: a gentle introduction to programming

Date :

December 2007

REF No:

4.22, 4.23

Contributors:

Srinath Perur

Std:

IV

Reviewers:
Brief
Description:

This lesson introduces the concept of programming through an activity.

Goal:

To introduce the broad concept of programming through a fun activity. A
secondary goal is to design the activity such that it eases the transition
into learning simple Logo.
Pre-requisites: None
Duration:
Two classes
Resources:

Detailed description:
When we want to tell the computer how to perform some task, we give it detailed, step-by-step
instructions. These instructions are together called a program. A program is usually written in a
programming language, which consists of some special keywords that the computer can understand.
In future lessons, we will use a programming language called Logo to make the computer perform
simple tasks. In this lesson, we will have an activity in which the students, without being aware of it,
will follow a process similar to programming in Logo.
The activity we will do for this lesson is called the Hopping game. The game is played as follows:
●

A grid is drawn on the floor and the centre square is marked.

●

Two to three objects are taken and placed on other squares of the grid. These could be balls or
sweets or any small thing that the class finds attractive.

●

●

Two students will play the game together. One student stands on the centre square. He will try
to move to the squares with the objects in them and pick them up. But he can only move by
hopping according to the instructions of his partner.
The partner stands at the edge of the grid and gives directions. He can only use the following
four instructions to guide his hopping friend:
1. Move forward by some number of squares
2. Move backward by some number of squares

3. turnright
4. turnleft
●

The game ends after all the objects in the grid have been retrieved
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For example, see the grid shown above. The cross represents the starting position of the hopper. A, B
and C represent the three objects placed in the grid. Now, a possible set of instructions that could be
given to the hopper to pick up the objects in that order are:

forward 1
turnleft
forward 1 (pick up A!)
backward 3
turnleft
backward 1 (pick up B!)
forward 4
turnright
forward 2 (pick up C!)
Of course, there can be many different ways of picking up the three objects in this example.
Lesson Plan:
The Hopping game can be treated as a fun activity and there is no need for any introduction at this
stage. Some guidelines for conducting the game:
●

Try to organise the game in a room with conveniently sized tiles. This will make drawing the
grid much easier and only the boundaries may need to be drawn.

●

Make sure the grid is neither too large nor too small. 7x7 and 9x9 would be appropriate sizes.

●

●

Try to make the objects to be retrieved something the children find attractive. For example,
there could be four sweets placed in the grid which the hopper and his partner could share after
retrieving.
Ensure that every child gets a chance either to give instructions or to be the hopper.
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Worksheet

1. Where will the turtle be after following these instructions? Trace the path with a
pencil and draw a turtle in the last square. One example is shown below:

forward 2
turnright
forward 3
turnright
forward 1

a.

forward 4
turnleft
forward 4
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b.

backward 4
turnright
forward 4
turnleft
forward 4
turnright

c.

forward 2
turnright
forward 2
turnright
forward 2
turnright
forward 2

2. Help the hungry turtle reach the carrots! Fill in the correct numbers in the blanks.
[Hint: first trace the path, then count the squares.]

forward ___
turnright
forward ___
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3. The green turtle and the red turtle want to meet in the centre square. Can you write
simple instructions for each of them so that they reach the square?
Green turtle

Red turtle
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Title:

Simple programming with Logo

Date :

December 2007

REF No:

4.24, 4.25, 4,26

Contributors:

Srinath Perur

Std:

IV

Reviewers:
Brief
Description:

This lesson introduces simple Logo programming.

Goal:

To introduce simple Logo commands as an extension of the activities
done in the last two classes, and to introduce the term program.
Pre-requisites: Lessons 4.22 and 4.23
Duration:
Three classes
Resources:

Detailed description:

Note: This lesson is meant to introduce simple Logo programming to children. The content in this
section is written to introduce teachers to the basics of Logo programming -- a brief description of the
conceptual model, practical information on how to open the application, how to enter commands and
run them, and so on. The lesson plan in the next section suggests a different approach when children
are to be taught. This is because children in the fourth standard may not be familiar with two ideas
that are very useful for working with Logo: the coordinate system and angles. The lesson is designed
such that some idea of angles is conveyed during the lesson. But care has been taken that none of
the examples or exercises require explicit use of the coordinate system.
A computer requires very detailed and precise instructions regarding how to go about performing a
task. A list of such instructions taken together is called a program. The person who writes a program is
called a programmer.
When we give instructions to other people, we use a language such as English or Hindi. For giving
instructions to a computer, we use a programming language. Just like the languages we speak, a
programming language consists of words called keywords or commands, and rules for putting them
together so that the computer can understand them. In this lesson we will take a look at how to write
simple programs in a language called Logo.
Logo
Let us now explore a small part of the programming language Logo. On your Edubuntu system, you
can click Applications->Education->KTurtle to get the following window.
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Run

Turtle

Canvas

The square in the right pane is called the canvas, and there is a turtle in the center. In the left pane
we can give Logo instructions to the turtle to move forward or backward, or turn by a certain amount.
The turtle has a pen, and will leave a trail of its movements on the canvas. Thus we can use the turtle
to trace a figure on the canvas. While Logo can be used to write larger programs, here we use only a
few keywords that help us to control the movement of the turtle and make it draw.
The Canvas
In the screenshot above, the canvas is the blank region in the right pane in which the turtle draws. The
canvas can be thought to be a fine invisible grid made of a large number of squares. (A magnified10 x
10 grid is shown below for illustration.) The canvas in KTurtle is a 300 x 150 grid by default, but it can
be changed as required.

The Turtle
The turtle can be thought of as a cursor on the canvas. It obeys the commands that we type into the
left pane of the KTurtle window. When we tell the turtle to move, we also must tell it how much to
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move. We express this in terms of the number of squares the turtle has to move on the canvas grid.
The turtle also leaves behind a trail as it moves, so we can use it to draw on the canvas.
Now let us run a small, one-line program to move the turtle forward by 50 steps. Note that since the
canvas grid is very fine, this is not a large distance. To do this:
Open the KTurtle application as show in the screenshot
Enter forward 50 into the left pane
Click on the Run button indicated in the above screenshot
You should find that the turtle moves a short distance forward. You may want to reduce the execution
speed to see the movement more clearly. The following screenshot shows the
effect of running this simple program.

Next let us say we want the turtle to turn right and then move another 50 steps. We then write in the
left pane turnright 90, where 90 represents the angle in degrees that the turtle has to turn, and
again forward 50 to get the following.
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Now, let us say we want to use what we have learnt to draw a square. We will abandon the current
canvas and start afresh by using the reset command. The following screenshot shows the program
and the square drawn by the turtle.
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Simple keywords
So far we have used the forward, turnright, reset and repeat keywords. A few more
commands are introduced in the lesson plan and exercises. A few simple commands are listed below.
reset

Positions the turtle at the centre of a blank canvas

turnright x

The turtle turns right by x degrees

turnleft x

The turtle turns left by x degrees

center

The turtle moves to the center of the canvas

penup

The turtle lifts its pen and leaves no trail as it moves

pendown

The turtle puts its pen down and leaves a trail as it moves

penwidth x

The width of the trail drawn by the turtle

hide

The turtle becomes invisible

show

The turtle becomes visible

wait x

The turtle waits for x seconds before executing the next
instruction

Logo can also be used to accomplish more complex drawings, and other tasks such as text
processing and mathematical calculations. We will see some of these in the next lesson. The KTurtle
application contains several example programs. Click on File->Open Examples in the KTurtle menu
and run these examples to see what the programs do. KTurtle comes with an excellent manual with
detailed instructions for learning Logo. This can be accessed by hitting F1 or by clicking Help->KTurtle
handbook on the KTurtle window.
Lesson Plan:
The lesson can start by refreshing the students' memories about the hopping game they played
earlier. Just as they directed their friends, now we will be directing a turtle in the computer. The
differences between the previous activity and using Logo will have to be specified:
●

Here the squares are very small and cannot be seen. They are also much more in number.
Therefore for the turtle to move a small distance, we will have to ask it to move many squares.
Here give a demo showing how much the turtle moves when the following pairs of commands
are entered and run. Also show that the reset command moves the turtle back to its original
position. Make it a point to set the execution speed to 'slowest' in the drop down menu. Also,
run each pair of commands separately for simplicity. You can also ask the class to suggest the
distance to be moved.
reset
forward 50
reset
forward 100
reset
forward 200
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In the last case, the turtle wraps around the canvas and draws from the other side.
that this is because the turtle cannot move outside the canvas.
●

Explain

By now the students will have noticed that the turtle draws a line as it moves. Explain that this
can be used to create drawings on the canvas. This is also a good time to introduce the
commands penup and pendown. Explain that the command penup causes the turtle to lift its
pen and so not draw as it moves. Demonstrate this by showing the difference between these
two programs:
reset
forward 100
reset
penup
forward 100

You can start using the word program at this stage. Just explain that a list of instructions given to a
computer is called a computer program.
Now demonstrate use of the pendown command as the opposite of penup. Here is a program that
draws a dashed line. Explain how it works first before giving a demonstration.
reset
forward
penup
forward
pendown
forward
penup
forward
pendown
forward
penup
forward
pendown
forward

10
5
10
5
10
5
10

Intrduce the center command with an example:
reset
forward 100
center
backward 100
center
Earlier in the hopping game, the directions used were turnright and turnleft. Now, mention that
the turtle needs to be told how much to turn right or left. Demonstrate these to show how the amount
to be turned is indicated from 0 to 90:
reset
forward 100
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reset
turnright 30
forward 100
reset
turnright 60
forward 100
Demonstrate that turning right or left by 90 takes a full turn in that direction:
reset
forward 100
center
turnright 90
forward 100
Just ask the students to remember that turning by 90 will cause a full right turn or left turn.

Note: It is desirable that the demos are done using a projector so that the class can be involved. If a
projector is not available, the demos can be done on one computer for small groups of students. It is
also important that every student gets some experience in entering a small program and running it.

Worksheet

1. A list of instructions given to a computer is called a computer p

2. Match the Logo commands on the left with what it makes the turtle do.
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.

3. Write a Logo program to draw a square with sides of length 100. The first two lines of
the program are given. Write the remaining commands and run the program!

forward 100
turnright 90
_____________
_____________
_____________
_____________
_____________
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4. Write a Logo program to draw the letter 'L' on the canvas as shown. The two arms of
the L are of length 100. (Hint: Move the turtle forward by 100, bring it backward by 100,
then turn right and move forward by 100.)

_______________
_______________
_______________
_______________

5. Write a Logo program to draw a plus sign on the canvas as shown. (Hint: Continue
the method used for drawing the 'L'.)
_____________
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_____________
_____________
_____________
_____________
_____________
_____________
_____________
_____________
_____________

6. What shape will the turtle draw when the following program is run? Draw it on the
empty canvas on the right. (The turtle has already performed the first two commands.)
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reset
turnright 30
backward 140
turnright 60
forward 140
turnright 60
backward 140
7. In this exercise you will learn a new command. Enter this program and see what it
does!
reset
forward 100
print "Hello"
turnright 90
forward 100
print "I am"
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turnright 90
forward 100
print "a"
turnright 90
forward 100
print "turtle!"
Now add the command penup as the second line of the program and run it. What
difference do you see? Can you write a program that prints your name on the canvas?

8. This program does something very interesting. Enter it and see what!
reset
penup
forward 120
pendown
penwidth 1
backward 30
penwidth 5
backward 30
penwidth 10
backward 30
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penwidth 15
backward 30
penwidth 20
backward 30
penwidth 25
backward 30
penwidth 30
backward 30
penwidth 35
backward 30
Now, can you say what does the command penwidth does?

9. Write any program you can think of by using the commands you have learnt so far!
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